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1.	 Overview

JoUp is a plugin for Adobe Acrobat used to impose PDF-documents. It is intuitive and very 
easy to use. The document to be imposed should already be opened and a JoUp template to be 
selected. JoUp then creates a new PDF-document with all the pages necessary to make a new 
imposed document.

JoUp has built in functions for creating templates in WYSIWIG mode. Both simple and com-
plex imposing schemes can be made very easily. JoUp adds drag and drop features to Acrobat 
for placing registration marks anywhere on the template and for moving objects around the 
page.

Several of the more advanced features are:

•	 automatic spot color bar

•	 lining out for proofing

•	 TrimBox editor

•	 Hot folder support for workflows (JoUp Pro)

2.	 Requirements

JoUp is available for both MacOS and Windows with he following requirements:

•	 MacOS X 10.4/10.5/10.6

•	 Windows XP/7

•	 Adobe Acrobat Professional 9/X

•	 Printing devices with PostScript Level 3
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3.	 Installation

3.1	 Windows

To install, close Acrobat, and simply copy the plugin, “JoUp.api” to the plug_ins folder of 
Adobe Acrobat, e.g.: „C:\Program Files\Adobe\Acrobat 9.0\Acrobat\plug_ins“. After restarting 
Acrobat, JoUp is ready to use.

3.2	 MacOS X

To install on MacOS X, navigate to the Adobe Acrobat application, usually found in the 
“applications”  folder of the boot-up hard drive. Either right click or Ctrl-click on the applicati-
on icon. A context menu  will appear.  

Click on “Show Package Contents” and then open the folder called “Contents”. There you  
will find a folder called “Plug-ins”. Copy „JoUp.acroplugin“ to that folder. After restarting 
Acrobat, JoUp is ready to use.
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4.	 User Interface

4.1	 The JoUp palette

After successful installation, the JoUp palette will be visible when restarting Acrobat.

The JoUp-Palette



JoUp 6.0 7

JoLauterbach Software GmbH

4.2	 The JoUp Menu 

The JoUp Menu

The JoUp Menu privides some basic functions like showing or activating the palette, creating 
a new template and preferences. 

4.3	 The JoUp Tool

The active tool controls keyboard and mouse clicks. JoUp provides also a tool, which must 
be activated, in case you want to edit templates or impose documents.

6.4.1	 Acrobat 9

With Acrobat 9 (and earlier versions) the JoUp tool is located in the „Advanced editing tool-
bar“

JoUp Tool with Acrobat 9

6.4.2	 Acrobat X

With Acrobat X it is recommended to add the JoUp tool to the „Quick Tools“ by right cli-
cking on the icon in the section „Tools->Plug-In Advanced Editing“

JoUp Tool with Acrobat X
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4.4	 The context menu

With the JoUp tool active a context sensitive context menu appears, when clicking with the 
right mouse button within the document.
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5.	 Imposing

Open the PDF document that you want to impose. If the JoUp palette is not visible, open it 
and click  “Impose“.

Choose template and binding
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Template:	 Template path

Second sheet:	 Template to use, if number of pages does not match the placeholders found in 
the template. If this field is empty, JoUp automatically creates empty pages 
for the document to be imposed. The entry can be cleared by pressing the 
„Choose“ button together with the „Shift“ key.

Document:	 The document to be imposed together with infos about number of pages, Trim- 
und CropBox.

Binding:	 Choose between Saddle Stich, Perfect binding and Envelope. With „Envelope“ 
only the first and last two document pages are processed.

Creep:	 Creep value for Saddle Stich processing mode.

Placing:	 Choose between placing by TrimBox or Centered.

Scale:	 Scaling factor.

From … To:	 Pages to be used for imposing

It is also possible to impose with the template open. In that case a standard file dialog pops up 
for choosing the document to be imposed. If there are any frames selected, only those frames are 
filled with pages from the document.

10



JoUp 6.0 11

JoLauterbach Software GmbH

6.	 Creating templates

The JoUp-palette provides all necessary functions for creating templates, both simple and 
complex ones.

6.1	 Preferences…

With „Preferences…“ the following dialog comes up:

Preferences

The popup menu „Origin“ defines the position of the Origin, top left or bottom left.

With „Drag and Drop for all docs“ it is possible to import PDF documents into all other PDF 
documents and not only to those created with JoUp.

The group „Units“ specifies the measurement units used for dialogs and/or the palette.

All preferences are stored within the text file „JoUp.ini“. By pressing „JoUp.ini...“ this file 
is opened by the default text editor. This file is located in „~/Library/Application Support/
JoLauterbach“ for Mac and in „~/My Documents/JoLauterbach“ for Windows.
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6.2	 New…

With „New…“ a new PDF document with a given width and height will be created by JoUp.

New Document

With „JobInfo“ active JoUp creates a frame at the bottom of the document, which will be 
filled with job information when imposing pages (see chapter 7.1 for more information). A job 
info frame is visualized with a „J“ in the frame center. With „Colorspace gray“ the black text 
within the jobinfo is black only (and not also in all other plates, good for digital printing).

The jobinfo frame

12
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6.3	 Frames…

Create Frames

With this function you can define the frames for the pages to be imposed. It is possible to 
create several frames in one step. Bleeding values are defined later with the palette. The option 
„Rotate frames by 90 degrees“ let you create the frames in landscape orientation.

2 frames side on side

13
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6.4	 Select Frames

The created frames are the container for the pages of the source document. To let JoUp know, 
what page is going into what frame, these frames have to be numbered. For this they must be 
selected with the mouse. JoUp installs a tool for that purpose, a rectangle with small crop marks. 
The tool can be found with the advanced editing toolbar (Tools->Advanced Editing->Show 
Advanced Editing Toolbar).

The JoUp tool

After activating the JoUp-tool you can select one or more of the frames created earlier. By 
using the shift-key you can expand or shrink existing selections.

6.5	 Frame numbering

A selected frame can be numbered by simply pressing a digit on the keyboard. E.g., pressing 
„4“ gives a frame number of 4. The number can also be entered via a dialog by pressing ‚N‘ 
with one or more frames selected and the JoUp tool active.

Frame numbering

The number of a frame is displayed in the middle of the top margin of the frame.
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6.6	 Adding and removing crop marks

With the dialog „Marks…“ crop marks can be added around selected frames:

Create crop marks

Crop marks added with JoUp

It is also possible to remove the marks. Without any frame selected you simpy click on 
„Marks“ and after confirmation all marks on all pages are removed. If you want to remove only 
marks around one or more pages, you have to first select those pages and the press „Marks“ 
together with the „Shift“ key.
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6.7	 Rotate

Beside position and size the frames have an additional important property, the rotation angle 
for placed pages. It can be a multiple of 90 degrees. Clicking „Rotate“ on the JoUp-palette sets 
the rotation angle to 180 degrees, pressing the Shift-key on clicking gives 90 degrees. An exi-
sting angle is added to the new setting.

2 frames with rotation angles of 0 and 180 degrees

2 frames with rotation angles of 90 and 270 degrees
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6.8	 Copy

With „Copy“ you can copy a complete sheet with all frames and marks. So it is very easy to 
create the back side of your template

Copy pages…

The field „Number of copies“ specifies, how much times the existing layout with all pages 
is copied. „Offset“ makes it possible to increment box numbers automatically, if desired. With 
JoUp Pro it is possible to mirror the page objects on copying (horizontally or vertically).
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6.9	 Bleeding

For one or more frames it is possible to define bleeding. Select the frames with the JoUp-tool 
active and press „B“ on the keyboard. The following dialog appears for a multiple selection:

Bleeding for multiple selection

Enter the value and press OK. All selected frames will be resized about the specified value in 
all directions. If the frames are placed side on side, these edges will not (!) be changed! If you 
want to resize all edges without restriction, activate the option „Symmetric“ before pressing OK.

If only one frame is selected, there is another dialog for specifying bleeding values for each 
margin separately:

Bleeding for single selection
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6.10	 Drag and Drop

JoUp adds drag and drop features to documents created with JoUp. When dropping a PDF 
document from the Finder (Windows Explorer), the first page of that document is placed in the 
dropped page at the according mouse position. So it is very easy to add custom marks to the 
template.

It is also possible to create most parts of a template with a layout application like Adobe 
InDesign or QuarkXPress, export as PDF and drop this into the template document.

6.11	 Position

Objects created by JoUp, frames and dropped marks, can be positioned either by moving 
them with the mouse or with the following dialog:

Position…

The entered values specify the bottom left corner of the selected object(s). It is also possible 
to change the position with the cursor keys in steps of 1 mm or 1 pt (1/10 of a mm or pt with 
shift-key).

6.12	 Show Guides

Show Guides
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By deactivating the checkbox „Show Guides“ JoUp does not draw the gray rectangles around 
the frames and their box numbers.

6.13	 Delete frames

Frames created with JoUp can be deleted by selecting these frames and pressing „Backspace“. 
By pressing „Delete“ only the content of the frame is removed. Please note, that for Acrobat 6 
and MacOS X you have to press the „Shift“ key together with „Delete“ to only remove the con-
tent.

6.14	 Duplicate/Mirroring

With the JoUp tool active you can copy page items by pressing „D“ on the keyboard. You can 
enter number of copies and their horizontal and vertical offset.

Duplicate

Selected frames can also be mirrored horizontally and vertically by pressing „H“ and „V“ 
with the JoUp tool active.

6.15	 Placing

Via „Place“ the first page of any PDF document can be placed within a sheet. It is placed in 
the bottom left corner and can be moved to any position by keyboard or via the according dia-
log.
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6.16	 Paper setup

An existing template can be modified in size by pressing the „Paper“ button in the palette.

Papierformat

Beside changing width and height of the template it is also possible to keep the page objects 
centered after the change.



JoUp 6.0 22

JoLauterbach Software GmbH

7.	 Advanced features

7.1	 Job info

By pressing „J“ with one frame selected this frame will assigned a special meaning, it will 
be converted to a jobinfo frame. This is a placeholder for job information, which is filled when 
imposing the page. The frame can be positioned anywhere on the page.

Job info frame

The jobinfo frame is filled with the following text objects:

	 •	 Pagination (Sheet 1A/B, etc.)

	 •	 Order number

	 •	 Document title

	 •	 Date/Time

	 •	 Color names (CMYK + all used spot colors)

The entries can be configured by double clicking the job info frame:

Configuration dialog of job info frame
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The top section is for entering other text strings for A/B, a general setting for all job info 
frames. The next section is for specifying, what text fields should be added to the frame. This 
setting is individal for each job info frame.

Order number and title are taken from the „Metadata“ of the document to be imposed. The 
title is taken from „File->Document Properties->Description“:

Title

The order number is taken from the entry „AN“ of the Custom sheet of the document proper-
ties dialog.

Order number
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7.2	 Spot color support

JoUp ships together with a special spot color bar „cmykxz.pdf“.

Spot color bar „cmykxz.pdf“

The spot colors X and Z in that mark are replaced during imposition by the first two spot 
colors found in the source document. It is possible to automatically replace more than two spot 
colors by adding an entry „Replace“ in the file „JoUp.ini“ in the same folder than the plugin.

[General]
...
Replace=XZABC
...

7.3	 Lining out

By pressing „T“ with the JoUp tool active you get thin black lines around the Trim Boxes 
of the placed pages for proofing. The color of those lines can be replaced by a special spot 
color, so that you can use the same print job for both proofing and printing. For that an entry 
„TrimLines“ has to be added to the file „JoUp.ini“ in the same folder as the plugin.

[TrimLines]
ColName=TL
CMYK=0 1 0 0
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7.4	 TrimBox Editor

A pdf document should contain a TrimBox for each page for exactly placing them into the 
frames of a template. Although it is possible to add the TrimBox with Acrobat itself, the inter-
face for that is not very easy to use, especially for rotated pages. To add that with JoUp activate 
the JoUp tool and click together with the Alt-key into the top left corner of the TrimBox. Keep 
the mouse button pressed and draw any rectangle. After releasing the mouse a dialog appears 
and you can enter the exact values for the TrimBox. All coordinates are relative to the top left 
corner of the visible page.

Setting the Trimbox

7.5	 Moving marks

JoUp supports moving marks. Those marks move into a given direction during imposition. 
A selected frame can be converted to a moving mark by pressing ‚F‘ on the keyboard with the 
JoUp tool active. The following dialog comes up:

Moving marks

With „MoveTo“ you the moving direction of the mark during imposition can be specified. 
The graphical content of the frame will be set to a black area.
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7.6	 Hot folder support (JoUp Pro)

With JoUp Pro it is possible to define input folder for automatic workflows. Those folders are 
checked periodically for incoming jobs to be imposed and moved to an according output folder. 
Any number of input and output folders can be specified via the configuration file „JoUp.ini“ in 
the same folder as the plugin JoUp itself.

[Hotfolder] 

In1=Macintosh HD/TestDaten/JoUp/Hotfolder/In1
Out1=Macintosh HD/TestDaten/JoUp/Hotfolder/Out1
Done1=Macintosh HD/TestDaten/JoUp/Hotfolder/Done1
T1=Macintosh HD/TestDaten/JoUp/Templates/2Up_A4.pdf
B1=R
D1=0,1

In2=Macintosh HD/TestDaten/JoUp/Hotfolder/In2
Out2=Macintosh HD/TestDaten/JoUp/Hotfolder/Out2
Done2=Macintosh HD/TestDaten/JoUp/Hotfolder/Done2
T2=Macintosh HD/TestDaten/JoUp/Templates/2Up_A4_3mm.pdf
B2=K

...

•	 InX:	 Input folder, checked periodically for incoming PDF documents

•	 OutX:	 Output folder,  original doc is moved to that folder after processing

•	 DoneX:	 Done folder, imposed doc will be created there

•	 TX:	 Template to be used for imposing for this hot folder

•	 BX:	 Binding (S = saddle stitch, P = perfect binding)

•	 DX:	 Displacement for saddle stitch (paper thickness)

For Windows the paths have to be entered in Window format, e.g.:

In1=C:\TestDaten\JoUp\Hotfolder\In1
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7.7	 Plate formats

If you have plate machines with different formats, it is necessary to create templates for each 
of them. Use the function „Plate...“ from the palette instead.

Define plate size

The plate size is assigned with the according entry in the popup menu. All available plate 
sizes have to be defined within „JoUp.ini“ within the section „Plates“:

[Plates] 

GTO=0 25 450 370
...

Left to the equal sign there is the name of the according format, right to it there are 4 values 
for distance in x/y and the width and height of the plate. If the distance in either direction is 
zero, the objects are centered in that direction.
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8.	 InRIP-Color Separation

JoUp adds support for „InRIP color separation“. With this technique composite Postscript is 
sent to the printer and the separation is done within the RIP. The according dialog is opened by 
pressing „p“ with the JoUp-tool active.

InRIP Color Separation

The dialog contains two lists. One for all spot colors found in the current document, and one 
for the plates to be printed. A selected spot color will be added to the plates list and a separate 
plate will be calculated for this spot color. All selected plates will be printed. Unselected spot 
colors will be converted to CMYK.

„Page Setup“ opens the standard page setup dialog of Acrobat. „Print…“ opens the standard 
print dialog of Acrobat for printing the document.
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9.	 Keyboard shortcuts

With the JoUp tool active the following keyboard shortcuts are available:

•	 J:	 The selected frame will be converted to a jobinfo frame

•	 B:	 Set bleeding values for selected frames

•	 F:	 The selected frame will be converted to a moving mark

•	 N:	 Number selected frames via a dialog

•	 T:	 Lining out mode on/off

•	 Arrow keys:	 Move selected frames horizontally or vertically in steps of 1 mm

•	 Backspace:	 Delete selected frames

•	 Delete:	 Clear frame content

•	 +/-:	 Move a frame up and down in the object hierarchy

•	 D:	 Duplicate frames

•	 H/V:	 Mirror frames horizontally or vertically

•	 M:	 Add/Remove cut marks

•	 Tab:	 Select next/previous frame in the object hierarchy

•	 C:	 Center frame content (for marks only)

•	 R:	 Rotate frame content (requires reoloading of content)
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